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I. GENERAL 

A.  Overview 

1.   Use of this Manual and the ECF Policies and Procedures 
 

This manual provides instructions on how to use the  Western District of 
Tennessee’s Electronic Case Filing (ECF) System.  This system allows properly 
authorized attorneys (Filing Users) to electronically file and retrieve documents.  It 
also facilitates the electronic service of documents on other Filing Users. 

 
Please note that screen captures are for purposes of demonstration and may not be 
exactly what is displayed from the current version of ECF and/or your browser. 

 
Use of the ECF System also requires a working knowledge of an internet browser 
(e.g., Internet Explorer or Netscape) and the ability to use a PDF reader-writer 
program (e.g., Adobe Acrobat).  Only the most generic instructions as to use of these 
type programs are provided in this manual. 

 
2.   Help Desk 

 
If you have questions about the ECF System after reviewing the ECF Manuals and 
completing the ECF On-Line Training or have problems filing a document, please 
email your questions and/or concerns to cmecfhelpdesk@tnwd.uscourts.gov . Clerk’s 
staff will be available to help you between 8:30 a.m. and 4:30 p.m. Central Time, 
Monday through Friday (excluding holidays) . 

 
This manual provides instructions on use of the ECF System and, therefore, includes 
some general information on types of external programs and hardware you will need 
for this purpose.  Court personnel cannot give you technical advice or assist you with 
specific questions regarding your chosen hardware, software programs (e.g., specific 
PDF reader-writer programs), or the internet (e.g., internet browsers).  Such questions 
should be directed to your hardware, software, or internet service provider. 

 
Systems can offer local technical support issues ranging from password problems, 
scanning issues, document conversion errors, etc.   

 
Additional information regarding electronic filing can be obtained from our web 
page:  www.tnwd.uscourts.gov 

 

or by writing to: CM/ECF- Western Division 
United States District Court 
167 N. Main, Ste. 242 
Memphis, TN 38103 
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or to: CM/ECF- Eastern Division 
United States District Court 
111 S. Highland Ave., Ste. 262 
Jackson, TN 38301 

 
NOTE:  Filing by facsimile is not allowed, but a facsimile submission is allowed to 
preserve the time for filing in the event of a Technical Failure or other equipment failure. 

 
ECF System Website 

 
https://ecf.tnwd.uscourts.gov 

 
 

Questions regarding PACER should be directed to the PACER Service Center. See 
infra § I.B.3. 

http://www.pacer.gov/ 
 

The PACER Service Center (PSC) is the National Technical Help Desk.  For 
technical questions, contact the PACER Service Center (PSC) at 1.800.676.6856. 
PSC is responsible for public support of the application including general setup 
questions, password administration, technical questions, and billing services. They 
will answer questions about browser problems or connection issues, installing and 
using Adobe Acrobat, and any PACER questions. Users may also e-mail questions 
which are answered on a daily basis. Telephone support is offered from 8:00 a.m. to 
5:00 p.m. Central Time.  The PSC e-mail address is  pacer@psc.uscourts.gov . 

 

 
3.   The Court’s Web Page and ECF System Capabilities 

 
The court’s web page (www.tnwd.uscourts.gov) will allow anyone with internet 
access to: 

 
• View or download the most recent versions of the court’s ECF manuals, 

handbooks, and forms referenced in said manuals; 
 

• Self-train on the web-based ECF tutorial and computer-based training modules; 
 

• Practice filing documents in the ECF “training” database; 
 

 
Filing Users may also: 

 
• View and save documents hyperlinked to the NEF (one time “free look”); 

 
• Electronically file documents in actual cases and electronically serve them on 

other Filing Users and Pro Hac Vice Participants (PHV Participants). 
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Persons with PACER accounts may also: 

 
• View docket sheets; 
 

• View filed documents in all cases (subject to some confidentiality limitations); 
 

• View various reports (e.g., civil cases report, judgments) for cases that have been 
electronically filed. 

 
4.   Electronic Service – Notice of Electronic Filing 

 
One of the major benefits of the ECF System is electronic service of most filed 
submissions.* When a document is filed using the ECF System, a Notice of Electronic 
Filing (NEF) is automatically sent to the e-mail addresses provided for the Filing 
Users and PHV Participants in that action.  The date on the NEF is the filed date. 
Filing is not complete until the NEF is produced. 

 
* By registering as a Filing User or Pro Hac Vice Participant, an attorney consents to 

electronic service of all filed documents other than documents for which electronic 
service is prohibited (e.g., summons, complaint, indictment, and warrants). 

 
NOTE:  Be sure the ECF System’s address(es) is/are removed from your spam filter so 
it will not reject the system’s e-mails. 

 
Individuals who receive electronic notification of a filing are permitted one “free look” 
at the document by clicking once on the associated hyperlinked document number 
embedded in the NEF.**  The document may be saved to your computer at that time 
for future “free” access. Subsequent retrieval of the case docket sheet and documents 
from the ECF System must be made through your PACER account and is subject to 
regular PACER fees. 

 
**  The hyperlink to access the document will expire after the earlier of: (1) the first 

use; or (2) 15 days from transmission of the NEF. Any time that same hyperlink is 
accessed after it has expired, the NEF recipient will be asked for a PACER login 
and will be charged to view the document. 

 
The attorney who electronically files a document must also make Traditional Service 
on pro se litigants and attorneys who are not Filing Users or PHV Participants.*** 
The NEF must be included with the documents served.  Proof of such service shall be 
electronically filed with the court within one (1) business day after the electronic filing 
of the document (as shown on the NEF). 

 
*** The NEF will indicate which attorneys have received electronic service and 

will also list associated counsel and any pro se parties who have not been 
served via NEF.  The Filing User who filed the document must make 
Traditional Service on any pro se parties and attorneys other than attorneys 
appearing pro hac vice who are listed as not having received the NEF. 
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5.   Failed Transmission of NEF, E-Mail Accounts and Returned E-Mail 
 

At the end of filing, the system will generate an NEF which verifies the transmission 
was received.  If you do not see the NEF before logging out, check PACER to see if 
the filing is reflected on the docket.  If it is, the transmission was successful.  If it is 
not, contact the Help Desk. 

 
After filing a document, an NEF will be sent by e-mail.  Review this e-mailed NEF to 
ensure that there are no apparent problems with the notice (i.e., the hyperlink works 
properly).  If you did see the system’s NEF before logging out of the system, but you 
did not receive an e-mailed NEF, check PACER to see if the document is reflected on 
the docket.  If it is, the problem is probably with your e-mail.  If it is not, the filing 
failed, and you should either refile or contact the Help Desk. 

 
If the hyperlink on your e-mailed NEF does not work properly, contact the Help Desk. 
If you learn that another party did not actually receive service despite being listed as 
served on the NEF, you are responsible for further service. 

 
You must maintain an e-mail account with enough storage space to receive electronic 
notices from the court.* If the size of your e-mail account is not sufficient, NEF e- 
mails will fail and be returned to the court where they will be stored for 30 days. The 
court will check failed e-mails and attempt to re-send.  After 30 days, they will be 
deleted from the system. 

 
* In general, an account with storage space of at least 100 megabytes is sufficient. 

The e-mail generated from the ECF System can be voluminous and exceed the size 
allocated for free e-mail accounts.  You may need to consider purchasing extra 
storage space from your Internet Service Provider (ISP). 

 
You, as the Filing User, are responsible for keeping the primary and alternative e-mail 
addresses you provide to the court current at all times.  To make updates: on the blue 
ECF Tool Bar, click on UTILITIES, My Account, Maintain your email, then follow 
the commands for updates.  The court should be notified within 24 hours if you are 
having difficulty with your ISP.  At the same time, you should work with the ISP to 
resolve the problem.  When the problem is resolved, notify the Help Desk so that the 
court can resend the NEF e-mails to the primary e-mail address on the account. 

 
6.   Participation and Transition Period 

 
Unless excused by the court, all members of the Western District of Tennessee Bar 
shall register as Filing Users.   Attorneys admitted pro hac vice may only  participate as 
Filing Users in the case(s) for which pro hac admission was granted., and shall be 
required to consent to electronic service. 

 
Pursuant to ECF Policy & Procedures 3.1: Pro Hac Vice Applicants must download 
Motion for Leave to Appear Pro Hac Vice, and e-file completed form into the 
appropriate case, along with a Certificate of Good Standing of the highest court in 
which admitted, and email a proposed order to the presiding judge’s ECF mailbox. 
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Attorneys are encouraged to begin participation as soon as possible to maximize the 
benefits of the system, including electronic service of filed documents and notice of 
court orders and hearings.* 

 
* In conjunction with start up of the ECF System, the clerk’s office will cease routine 

use of facsimile to deliver hearing notices and orders to attorneys. Filing Users and 
PHV Participants will receive immediate notice of filings through NEF’s.  Parties 
proceeding pro se and attorneys admitted to this court’s bar who are not Filing 
Users will receive hearing notices and orders through regular mail unless otherwise 
directed by the court. 

 
7.   Signatures 

 
Unless an individual judge’s preference indicates otherwise, the Filing User’s login and 
password in conjunction with an s/ and the Filing User’s typed name on the filed 
document serve as the signature: s/ John Doe 

 
Documents that require multiple s/attorney names should be filed in compliance with 
ECF  Policy and Procedures Section 10.4 which authorizes the Filing User to add 
multiple attorney names.  Each attorney shall be represented by an s/attorney name and 
will be added to the case.  The attorney filing the document represents that he or she 
has obtained the original signatures on a hard copy of the document in question and has 
that document in his or her possession. 

 
Some documents which bear the signatures of persons other than the particular Filing 
User who filed the document (including other Filing Users) must be electronically filed 
as scanned images (e.g., affidavits) except where other procedures are required 
(e.g.,documents signed by multiple attorneys). Special rules apply to a Filing User’s 
retention of documents containing original signature(s).  See ECF Policy and 
Procedures Section 10.5. 

 

 
8.  Format of Submitted Documents 
 
  Unless a document is required to bear an original signature (see section 7), or is a copy of 
  a paper record from an external source (see section 15), the PDF document should be  
  generated directly from its original word-processing format, rather than being printed to       
      paper and scanned into PDF format.  
 
9.   Docket Text Orders and Notices 

 
Judges, their staffs, and the clerk’s office have the ability to make docket entries which 
do not include an attached PDF document.  For example, a judge may enter a text order 
granting or denying a motion by entering the ruling directly on the docket. 

 
This docket entry will generate an NEF reflecting the content of the docket entry, 
however there will not be a hyperlink to an image associated with the docket entry. 
The NEF is delivered to all parties and serves as notice of the order.   Notices of 
hearings may also be given through service of an NEF reflecting a text entry on the 
docket. 
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The NEF is electronically delivered to all Filing Users and PHV Participants.  A hard 
copy will be delivered by other means (generally by regular mail) to all other attorneys 
and to pro se parties. 

 

10. Quality Assurance 
 

The clerk’s office will perform a quality assurance review of new civil case filings 
entered by Filing Users.  If the clerk’s office discovers an error that requires correction, 
the clerk’s office will make an annotation on the docket which will generate an NEF.  
The NEF notifies you of a Deficiency Notice or a Courtesy Notice, depending on the 
nature of the error.  The NEF is sent to all case participants and to the judge to whom 
the case is assigned. 

 
The NEF will either indicate that the clerk’s office policy does not require any further 
action (Courtesy Notice) or will instruct you to take further action to remedy the 
apparent error (Deficiency Notice).  For instance, if the Filing User failed to pay the 
filing fee, a Deficiency Notice will be entered giving the Filing User one business day 
to correct the deficiency. 

 
While the quality assurance review conducted by the clerk’s office will uncover some 
errors, other errors, particularly involving the filing of the wrong document, may be 
discovered only by the Filing User or others involved in the action. 

 
Some common causes of erroneous filings include: 

 
• posting or attaching the wrong PDF file to a docket entry; 

 
• selecting the wrong document type from the menu; 

 
• entering the wrong case number; or 

 
• failing to sign document in correct format. 

 
These type errors can be minimized or eliminated by viewing PDF files before posting 
or attaching them and by double checking entries before transactions are finalized in 
the ECF System.  The ECF System does not permit changes or modifications to misfiled 
document(s) or incorrect docket entries after the transaction has been accepted. 

 
NOTE:  If an erroneous filing results in failure to meet a deadline, relief should be 
sought from the presiding judge. 

 
11. Judicial Preferences and Proposed Orders 

 
Different judges will have different requirements as to the filings. Each judge’s 
instructions and other preferences (including delivery method and timing) are 
posted on their individual websites. 

 

 
Proposed orders are to be sent in word processing  format (e.g. WordPerfect, Microsoft 
Word) to the assigned judge’s chambers e-mail address which can be obtained from our 
web page under Case Information, Chambers Email Addresses or by calling the clerk’s 
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office. 
 
 

12. Technical Failure 
 

A Technical Failure is defined as a malfunction of court-owned or court-leased 
hardware, software, or telecommunications facilities which results in the inability of a 
Filing User to electronically file a document.  Technical Failure does not include 
malfunctioning of a Filing User’s equipment, hardware, or software.  facsimile 
numbers are provided on the last page of this manual or, if you still have e-mail 
functionality, calling the Help Desk for instructions and a possible e-mail address to 
use for that filing).  You must still perfect proper electronic filing within one business 
day after the Technical Failure is remedied. 

 
13. Malfunction of Filing User’s Equipment 

 
If your equipment malfunctions, either hardware or software, you may preserve your 
time for filing using the same methods as allowed for Technical Failures.  You must 
still perfect proper filing within one business day after preserving your time.  The filing 
should be perfected by electronic filing on the ECF System.  In the event electronic 
filing is not possible, you should call the Help Desk to arrange filing by the Traditional 
Filing Method or other means (e.g., if you still have e-mail functionality, you may be 
provided with a specific e-mail address to use for that filing). 

 
14. Public Access and Sensitive Information 

 
The ECF System will facilitate public access to court documents.  Together with the 
benefits provided, comes an increased risk of misuse of sensitive information.  For this 
reason, special rules apply to the inclusion of confidential business information, as well 
as certain personal information (e.g., names of minors, personal identification numbers, 
financial information, and identifying information relating to jurors).  These rules place 
the burden on the individual making the filing to ensure proper protection.* 

 
* The same risks apply regardless of whether the document is filed by the Traditional 

Filing Method or electronically through the ECF System.  The same protections 
should, therefore, be applied regardless of the filing method. 

 

 
15. Attachments and Exhibits 

 
Attachments and exhibits to motions or memoranda must be submitted in electronic form 
as attachments to the main document.  The following rules govern these attachments: 

 
Excerpts.  Only pertinent excerpts of the referenced document(s) should be submitted 
unless the full document is sufficiently short or the relevant excerpts so extensive that 
submission of excerpts would not result in a significantly shorter document.  Excerpts 
should be identified as such and should include appropriate identifying and authenticating 
pages (e.g., deposition cover page or first and last pages of contracts). 

 
Originals.  The original or complete hard copy of a document for which excerpts are filed 
electronically need not be filed unless requested by the court. 

 

Size.  A single attachment may not exceed 10 MB (10,000 KB) in its PDF form. 
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Scanning Guidelines. Documents which are scanned from paper, rather than being 
generated via a word-processing program, should be scanned at 300 dpi and in black-
and-white. Scanning at higher resolutions, or in color or greyscale, will result in much 
larger documents, which are likely to exceed the 10 MB limitation. 

 
Multiple Attachments.  Multiple exhibits (or other attachments) may be linked to the 
primary document as individual attachments or, if they do not exceed the allowable size, 
combined as a single attachment.  If multiple exhibits are linked as a single attachment, 
they shall include a cover sheet indexing the exhibits.  If this method is used, the Filing 
User is strongly encouraged to include internal bookmarks to aid the court in electronically 
locating the proper exhibit. 

 

 
B.  Getting Started 

 
1.   Hardware and Software Requirements 

 
Technical requirements are minimal and inexpensive. All that is needed is access to a 
personal computer with: 

 
• the ability to create or convert documents into Portable Document Format (PDF) 

(one or more of the following): 
 

• PDF writer software (e.g., Adobe Acrobat) 
 

• a word processor that can create PDFs 
 

• a scanner and software to create PDFs 
 

• an internet connection to access the ECF System and e-mail. Dial-up connections 
work, but a faster connection (DSL, high speed cable, etc.) is recommended. 

 
• an approved internet browser.  The ECF System has been tested and works correctly 

with Internet Explorer Version 7 and 8, and Mozilla Firefox 3.5. Although not 
rigorously tested and certified, the ECF System also seems to work equally as well 
with Internet Explorer 9, Google Chrome, and later versions of Mozilla Firefox. 

 
• PDF reader software (such as Adobe Acrobat Reader) 

 
• an e-mail address 

 
• an ECF account 

 
• a PACER account.  While Filing Users may file documents without a PACER 

account, they will be limited in their ability to retrieve documents or to query the 
ECF System without a PACER account. 

 
Portable Document Format (PDF) is the key to the system. PDF makes all documents 
viewable in their original format on any computer whether they were scanned or 
converted from a word processing document. 
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2.   Credit Card Requirement 
 

In order to file an initiating or other document which requires payment of a filing fee 
(e.g., motion for pro hac vice admission), you must follow the applicable policy in this 
manual - .  Two exceptions to this rule are initiating an action in forma pauperis and 
filing notices of appeal (which may, in some instances, be filed without prepayment of 
the filing fee).* 

 
* If you are seeking to file the action in forma pauperis, you may initiate the action 

without prepayment of fees by including an electronically-filed Application to 
Proceed without Prepayment of Fees along with your initiating documents.  You 
may wish to contact the Help Desk for additional assistance. 

 
3.   PACER Registration 

 
Filing Users must have a PACER account in order to view filed documents (except the 
one “free look”) and to use the Query and Report features of the ECF System.  If you 
do not have a PACER login, contact the PACER Service Center to establish an account. 
You may call the PACER Service Center at 1.800.676.6856 for information or to 
register for an account. Also, you may register for PACER online at: 

 
http://www.pacer.gov/register.html 

 

A link to PACER’s site is provided on the court’s website. 
 

For CM/ECF technical questions, contact the PACER Service Center (PSC) at 1-800- 
676-6856 . PSC is responsible for public support of the CM/ECF application including 
general setup questions, password administration, technical questions, and billing 
services. Users may also e-mail questions which are answered on a daily basis. 
Telephone support is offered from 8:00 a.m. to 5:00 p.m. CST. 

 
4.   Registering as a Filing User 

 
Before you are registered as a Filing User, you must submit a completed ECF Attorney 
Registration Form.  You will be assigned a Filing User identification name (login) and 
password.  Your login name will be the last five digits of your state issued bar id and 
the initials of your first and last name (e.g. 55555cg).  The login and password, in 
conjunction with an s/ and your typed name on the document, serve as the signature for 
purposes of Fed. R. Civ. P. 11. 

 
You may obtain the Electronic Case Filing Registration Form by calling the Help Desk 
or by going to the court’s website (www.tnwd.uscourts.gov). 

Completed registration forms should be faxed (901-495-1250) or mailed to: 

ECF System Registration or ECF System Registration 
United States District Court United States District Court 
167 N. Main St., Ste. 242 Rm 262, 111 S. Highland Ave. 
Memphis, TN 38103 Jackson, TN 38301 

Fax 731-421-9210
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Once an account has been established, your login and password will be sent to you by 
e-mail from the clerk’s office. 

 
Filing Users agree to protect the security of their passwords. Should your password be 
compromised, you are responsible for immediately changing it according to the 
instructions provided with your login and password and in this manual. If you lose or 
forget your password, call the Help Desk, and a new password will be issued.  Court 
personnel do not have and cannot provide you with your current password. 

 
To practice electronic filing activities, you can visit a training version of the system on 
the Internet at http://ecf-train.tnwd.uscourts.gov. 

 
We strongly recommend that you practice in this “training” database before filing 
documents in the “live” ECF System database. 

 
5.   Setting up PDF Reader and Converting to PDF 

 
You will use PDF software for two purposes.  First, you will use PDF reader software 
to view documents filed in the ECF System.  Second, you will use PDF writer software 
(or similar capabilities in a word processing or scanning program) to convert 
documents to PDF for filing.  Only PDF documents may be filed using the ECF 
System. 

 
Important Reminder:  Before completing your transmission in the ECF System, be 
sure to preview the PDF document to ensure that it appears in its entirety, is not beyond 
the size limit, and is in the proper format. 

 
Preferred conversion methods.  As a general rule, converting from word processing 
to PDF is preferred over scanning because the resulting document is smaller (requires 
fewer bytes of storage space) and because the text is searchable. 

 
 

Some documents must be scanned.  You will be required to file a scanned image of 
certain types of documents.  First, exhibits normally will need to be scanned rather than 
converted, even if the underlying document is available in word processing form. 
Second, certain documents bearing third party signatures (e.g., affidavits) will need to 
be scanned.  (Documents bearing multiple attorney signatures are generally handled 
differently.  Special retention rules apply to all documents bearing an original signature 
when a scanned document or other document bearing a substitute (s/) signature is filed. 

` 
Conversion using PDF Writer Programs.  Various vendors provide software to 
create PDF documents.  The Federal Judiciary does not endorse or recommend any 
specific PDF software.  For purposes of illustration, however, we provide instructions 
based on one commonly used program, Adobe Acrobat Writer.* 

 
* These instructions are given as an illustration only.  You should consult materials 

provided by your software vendor for more detailed instructions or if these 
instructions do not work.  When installing and using any software, please review 
and follow the software vendor’s directions. 
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If you have installed Adobe Acrobat Standard or Professional, you can convert your 
word processing document to PDF while still “in” your word processing document. 
While in the document, select the print function, then select “Acrobat PDF Writer” or 
“Adobe PDF” from the drop down list of available printers.  The printer name varies 
based on the version of Acrobat installed on the computer.  This “print” process saves 
the file in PDF, with a “.pdf” file extension. (Depending on the word processing 
program being used, it may be necessary to find the printer selection option elsewhere.) 

 
Conversion using Word Processing Program.  You may also create PDF files using 
some newer word processing programs, although this may create a larger file and is not, 
therefore, the preferred method.  For example, in WordPerfect 9, 10, 11, and 12, you 
can click on “File” and then “Publish to PDF” to convert your WordPerfect file (.wpd) 
to PDF. MS-Word (up to version XP) does NOT have this capability. 

 
Conversion via Scanner.  Some of the latest generation of scanners have the ability to 
directly scan to PDF.  Review the instructions provided with your scanner to determine 
if your scanner has this capability. 

 

 
Special Situations 

 

 
6.   Sealed Documents 

 
Sealed documents may be filed in the ECF system by selecting the proper event. 
However, access will be restricted to court users unless an order granting access to an 
attorney is entered by the presiding Judicial Officer. 

 
7.   Filings Requiring Prior Approval 

 
If the document you wish to file requires leave of court, such as an amended complaint 
filed after a responsive pleading or a document filed out of time, you should file your 
motion for leave via the ECF system and simultaneously email your proposed amended 
document to the presiding judge’s chambers email address. If your motion is granted, 
the order will either indicate that the document is deemed filed or will direct you to 
electronically file your document. 

 
8.   Proposed Orders 

 
Proposed Orders should be submitted, in word processing format,  to the e-mail 
address of the district judge assigned to the case.  The e-mail should include the 
document number of any associated motion filed through the ECF system. Proposed 
Orders in civil cases must comply with Local Civil Rule 7.2(a)(1)(A). 
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To the extent it is practical and reasonable to do so, electronic data filed with the court 
should be converted from a word processing system directly to a PDF file using a 
program such as Adobe Acrobat, rather than scanning a paper copy of the document 
into a PDF image file.  Conversion from word processing allows for searchability 
within a document.  If a scanned PDF document is submitted, it must be previewed for 
readability. 

 
Because all documents must be submitted in a Portable Document Format (PDF), fonts 
and resolution should be chosen for best quality conversion. The court only allows use 
of the following fonts (for documents to be converted from word processing format) 
because they convert best: Times New Roman, Arial, and Courier New.  Size of font 
must be (at least) 12 point. 

 
3.   Signatures and Retention 

 
The Filing User’s login and password in conjunction with an s/ and the Filing User’s 
typed name on the filed document serve as the signature.  Documents which bear the 
signatures of persons other than the particular Filing User who filed the document 
(including other Filing Users) must be electronically filed as scanned images (e.g., 
affidavits) except where other procedures are required (e.g., documents signed by 
multiple attorneys).  Special rules apply to a Filing User’s retention of documents 
containing original signature(s). 

 
4.   Conventions Used in this Manual 

 
• Data to be entered by the Filing User is shown enclosed in angle brackets: <data to 

be entered>. 
 

• Command buttons are represented in this manual in [bracketed boldface type]. 
 

• Hyperlinks are represented in underlined type. 
 

 
5.   How to View a PDF Document 

 
These instructions are given based on the most commonly used PDF reader program, 
Adobe Acrobat.  Other PDF reader programs may be used and may differently operate. 

 
• Start the PDF program (e.g., Adobe Acrobat). 

 
• Go to [File Menu] and choose [Open]. 

 
• Click on the location and file name of the document to be viewed. 

 
• If the designated location is correct, and the document is in PDF, the PDF program 

will load the file and display it on the screen. 
 

• If the displayed document is larger than the screen or consists of multiple pages, the 
scroll bars may be used to move through the document. 
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If you believe your last login date and time are incorrect, or suspect an unauthorized party 
is using your login and password, please immediately change your password in the ECF 
System and telephone the court’s Help Desk. 

 
The ECF System does not allow you to log-in if you have not logged out of your prior 
session or if someone else, e.g., your assistant, is logged in as you.  You will get a screen 
asking if you want to cancel or “continue” the log-in process.  If you choose to continue, 
the ECF System will log you on and “bump” the prior log-in. 

 

 
12. Selecting ECF System Features 

 
The ECF System provides the following features that are accessible from the Attorney 
Event Menu Bar at the top of the opening screen. 

 
[Civil]:        Select to electronically file all civil case pleadings, motions, and other 

civil documents. Select to electronically file miscellaneous documents 
(documents not in a case or proceeding). 

 
[Criminal]: Select to electronically file all criminal case pleadings, motions, and other 

criminal documents. 
 

[Query]: Query the ECF System by specific case number, party name, or nature of 
suit to retrieve documents that are relevant to the case. You must log-in to 
PACER before you can query the ECF System. 

 
[Reports]: Choose [Reports] to retrieve docket sheets and reports.  You must log-in 

to PACER before you can view ECF System reports other than the 
[Calendar Events Report]. 

 
[Utilities]: View your personal ECF System transaction log and maintain personal 

ECF System account information in the Utilities area of the ECF System. 
 

[Search]: Search the ECF menus. Note: the Search feature does not work in Google 
 Chrome. 

 
[Logout]: Exit from the ECF System.  This prevents further filing with your 

password until the next time you log-in.  Failure to properly log-out of the 
ECF System will leave your account logged in, and you will get a warning 
message asking if you want to cancel or continue login.  If you choose to 
continue, the ECF System will log you on and “bump” the prior log-in. 
You will get a similar message if you are in the system and the idle 
timeout logs your account off.  This will occur after 30 minutes of no 
activity. 

 
Filing Users will use the ECF System to electronically self-file and docket with the 
court a variety of documents for civil cases. 
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We recommend that you set your browser so that the cache is automatically cleared 
out frequently and your system is always retrieving fresh information directly from 
the Internet. 

 
Following are instructions for use with the ECF System’s recommended browsers. If 
you are using a different version or browser manufacturer, please refer to the 
appropriate documentation or web site for detailed information they may have 
provided on this topic. 

 
For Internet Explorer: 
1.   On the Tools menu of your toolbar, click Internet Options. 
2.   Click the General tab. 
3.   In the Browsing History section, click the Delete button. 
4.   A new window will pop up. Check only Temporary Internet Files. 
5.   Click Delete. The new window will close. 
6.   Click OK to close Internet Options. 
 
For Mozilla Firefox: 
1. On Windows, select Options from the Tools menu. 
2. On a Macintosh, select Preferences from the Edit menu. 
3. Click the Advanced button. 
4. Select the Network tab. 
5. In the Cached Web Content section, click the Clear Now button. 

 
For Google Chrome: 
1. From the “wrench” menu, select Tools → Clear Browsing Data. 
2. Check only Empty the Cache. 
3. Click the Clear Browsing Data button. 


